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Evaluation Board for 1 MSPS
12-/10-Bit ADCs

EVAL-AD7476/AD 1411

FEATURES

Full-featured evaluation boards for the AD7476 and AD7477
devices

Evaluation control board (EVAL-CONTROL-BRD2) compatible

Standalone capability

On-board analog buffering and voltage reference

Various linking options

PC software for control and data analysis when used with
EVAL-CONTROL-BRD2

GENERAL DESCRIPTION

This data sheet describes the evaluation boards for testing the
AD7476 and AD7477 devices. The AD7476/AD7477 are,
respectively, 12 bit and 10 bit, high speed, low power successive
approximation ADCs. The devices operate from a single 2.35 V
to 5.25 V power supply and feature throughput rates up to

1 MSPS. These ADCs contain a low noise, wide bandwidth
track-and-hold amplifier to handle input frequencies in excess
of 6 MHz. The AD7476/AD7477 device data sheet should be
used in conjunction with this data sheet.

On-board components for these evaluation boards include:

e  One AD780, a pin programmable 2.5 V or 3 V ultrahigh
precision band gap reference.

e One REF195 precision band gap voltage reference
providing a 5 V reference voltage.

e One OP467 quad op amp to buffer the analog inputs.

Due to its standard pinout, the AD780 reference can be swapped
for the AD680, a 2.5 V low power reference. Likewise, the
REF195 can be easily interchanged for another reference within
the same voltage range from the REF19x family.

Various link options are provided in Table 2.

These evaluation boards are equipped with a 96-way connector.
This 96-way connector is compatible with the EVAL-CONTROL-
BRD2, also available from Analog Devices, Inc. External sockets
are provided for the A input, the Vix input and the Vausep input.
Note that the EVAL-CONTROL-BRD2 operates with all Analog
Devices evaluation boards with part numbers ending in the
letters CB.
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EVALUATION BOARD HARDWARE

POWER SUPPLIES

When using this evaluation board with the EVAL-CONTROL-
BRD2, all supplies are provided from the controller board
through the 96-way connector.

When using the board as a standalone unit, external supplies
must be provided. This evaluation board has seven power

supply inputs: AVop, Aexp, +12 'V, =12V, Aeno, DVob and Denp.

The Voo for the AD7476/AD7477 can be supplied either from
the EXT_VDD external supply or from the selected reference
chip. In addition, +12 V and —12 V are used to supply the
AD780, the REF195, and the OP467 quad op amp.

0 V is connected to one or both of the Acxo inputs. The DVop
input can be used to supply a separate +5 V for the 74LS04
DVop pin. The Dexp input must be tied to 0 V. The supplies are
decoupled to the relevant ground plane with 10 uF tantalum
and 0.1 pF multilayer ceramic capacitors at the entry point to
the evaluation board. The supply pins of the quad op amp and

Table 1. Initial Link and Switch Positions

the references are also decoupled to Aenp with 10 pF tantalum
and 0.1 pF ceramic capacitors. The AD7476/AD7477 AVpp
supply pin is decoupled to Axp with 10 pF tantalum and 0.1 pF
multilayer ceramic capacitors.

Extensive ground planes are used on this board to minimize the
effect of high frequency noise interference. There are two
ground planes, Aenp and Deno. These are connected at one
location in close proximity to the AD7476/AD7477.

INITIAL SET-UP CONDITIONS

Care should be taken before applying power or signals to the
evaluation board to ensure that all link positions are as per the
required operating mode. Failure to do so could result in
damage to the evaluation board.

Table 1 outlines the default positions of all links when the board
is shipped. All links are set so that all power supplies and
control signals are supplied by the EVAL-CONTROL-BRD2.

Link No. Position Function

LK1 Removed 50 Q termination resistor is not applied to the input of the VIN circuit.

LK2 Removed AD780 is set to provide a 2.5 V reference.

LK3 Removed 50 Q termination resistor is not applied to the input of the bias-up circuit.

LK4 Removed This is not relevant due to the position of LK12.

LK5 A Voo is selected as the dc bias voltage for the bias-up circuit.

LK6 A +12 Vs supplied from the EVAL-CONTROL-BRD?2 via J4.

LK7 A —12Vis supplied from the EVAL-CONTROL-BRD?2 via J4.

LK8 to LK9 B SCLK signal from the EVAL-CONTROL-BRD?2 is not inverted (for faster values of SCLK).
LK10 Removed This is not relevant due to the position of LK8 and LK9 (the 74LS04 is not in use).
LK11 A AIN SMB is connected to the input of the analog input buffer.

LK12 B Voo for the AD7476/AD7477 is supplied from the EVAL-CONTROL-BRD2 via J4.
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LINK OPTIONS

Twelve link options must be set for the required operating setup before using the evaluation board. The functions of these options are
outlined in Table 2.

Table 2. Link Functions

Link No.

Function

LK1

Selects a 50 Q termination on the analog input buffer circuit, the AIN socket.
When this link is installed, 50 Q termination is applied.
When this link is uninstalled, 50 Q termination is removed.

LK2

Controls the program pin of the AD780 voltage reference.
When this link is installed, the AD780 output voltage is set to 3 V.
When this link is uninstalled, the AD780 output voltage is set to 2.5 V.

LK3

Selects a 50 Q termination on the input of the bias-up circuit, the VIN socket.
When this link is installed, the 50 Q termination is applied.
When this link is uninstalled, the 50 Q termination is removed.

LK4

Connects the output of either the REF195 or the AD780 to the Voo pin of the AD7476/AD7477 (if Link 12 is in Position C).
In Position A, the AD780 supplies the Vpp voltage for the AD7476/AD7477.
In Position B, the REF195 supplies the Voo voltage for the AD7476/AD7477.

LK5

Sets the dc bias voltage that is applied to the optional bias-up circuit.

In Position A, the bias voltage is set to the same level as the voltage that is applied to the AD7476/AD7477 Voo pin. In this
configuration, a bipolar analog input applied to the VIN SMB socket is biased up by the bias circuit and is presented at the
Veiaseo SMB as an unipolar signal biased around Voo/2.

In Position B. the bias voltage is set to Aanp. In this configuration, the bias-up circuit is not used.

LK6

Selects the source of the +12V supply.
In Position A, the +12 V is supplied from the EVAL-CONTROL-BRD2 through the 96-way connector.
In Position B, the +12 V is supplied from an external source through the power connector, J6.

LK7

Selects the source of the —12'V supply.
In Position A, the —12 V is supplied from the EVAL-CONTROL-BRD2 through the 96-way connector.
In Position B, the —12 V is supplied from an external source through the power connector, J6.

LK8 to
LK9

Controls the transfer of data from the AD7476/AD7477 during a conversion for various frequencies of SCLK.
These links should be in Position A for slower SCLK frequencies, giving valid data on the rising edge.
These links should be in Position B for fast SCLK frequencies, giving valid data on the falling edge.

LK10

Selects the source of the Vcc +5 V supply for the 74LS04, an inverting bufffer.
In Position A, Vcc power is supplied from the same power source supplying the AD7476/AD7477 Voo pin.
In Position B, Vcc power must be supplied from an external source via the power connector, J5.

LK11

Connects the input of the Vin analog buffer to the AIN input socket or to Asnp.

In Position A, the AIN socket is tied to the input of the Vix buffer. In this configuration, an analog signal applied to the AIN
input socket is buffered and presented at the AD7476/AD7477 Vi input.

In Position B, the Vin buffer input is tied to Acno.

LK12

Selects the source of the Voo supplied to the AD7476/AD7477.
In Position A, the Voo must be supplied from an external source via J5.
In Position B, the Voo is supplied from the EVAL-CONTROL-BRD2.
In Position C, the Voo is supplied from one of the voltage references, the AD780 or the REF195.
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INTERFACING THE EVALUATION BOARDS Figure 2 shows the pinout for the 96-way connector.

) ) Table 3 and Table 4 list the pin designations and descriptions.
Interfacing the EVAL-CONTROL-BRD2 to the evaluation .
) ; ) The unused pins of the 96-way connector are not shown.
board is accomplished via a 96-way connector, J4.

1 8 16 24 32

Oo000000000000000000000000000000

Plug the 96- nnector on th luation board directly in 00000000000000000000000000000000
ug the 96-way connector on the evaluation board directly into 00000000000000000000000000000000

the 96-way connector on the EVAL-CONTROL-BRD2. T 5 = 7 =

Figure 2. Pin Configuration for the 96-Way Connector

0w >

06243-002

Table 3. 96-Way Connector Pin Description Table 4. 96-Way Connector Pin Functions, J4'
Signal Description Pin ROW A ROW B ROW C
DRO Data Receive Zero. This input is connected to the 1
SDATA pin of the AD7476/AD7477. 2
TFSO/RFSO | Transmit/Receive Frame Sync Zero. These two 3
outputs are connected to the CS pin of the 4 DGND DGND DGND
AD7476/AD7477. 5 DRO
SCLKO Serial CIocI§ Zero.This serial clock is coqnected to 6 TESO RFSO
the SCLK pin of the AD7476/AD7477 with the
option of an inverting buffer. 7 SCLKO SCLKO
DGND Digital Ground. These lines are connected to the 8
digital ground plane on the evaluation board. It 9
allows the user to provide the digital supply via the 10
connector along with the other digital signals. 11
AGND Analog Ground. These lines are connected to the 12 DGND DGND DGND
analog ground plane on the evaluation board. 13
AVop Analog +5 V Supply. These lines are connected to 14
the AVop supply line on the board.
+12V +12V Supply. This line is connected to the +12V 15
supply line on the board via LK6. 16 DGND DGND DGND
-12V —12V Supply. This line is connected to the —12V 17
supply line on the board via LK7. 18
19
20 DGND DGND DGND
21 AGND AGND AGND
22 AGND AGND AGND
23 AGND AGND AGND
24 AGND AGND AGND
25 AGND AGND AGND
26 AGND AGND AGND
27 AGND
28 AGND
29 AGND AGND AGND
30 -12V AGND +12V
31
32 AVbp AVbp AVbp

" Note : The unused pins of the 96-way connector are not shown.
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SOCKETS

There are three input sockets relevant to the operation of the
AD7476/AD7477 on these evaluation boards. The functions of
these sockets are outlined in Table 5.

Table 5. Socket Functions

Socket | Function

J1 Subminiature BNC socket for AIN analog input.

J2 Subminiature BNC socket for analog input to bias-up
circuit, Vin.

J3 Subminiature BNC socket for analog output from bias-
up circuit, Veiaseo.

CONNECTORS

There are three connectors on the AD7476/AD7477 evaluation
boards as outlined in Table 6.

Table 6. Connector Functions

Connector | Function

J4 96-way connector used to Interface to the
EVAL-CONTROL-BRD2.

J5 External Voo and Acno power connector.

J6 External +12V, —12V, and Asno power connector.

OPERATING THE EVAL-AD7476/AD7477

The evaluation board can be operated as a standalone unit or in
conjunction with the EVAL-CONTROL-BRD2.

When operated with the EVAL-CONTROL-BRD2, all supplies
and control signals to operate the AD7476/AD7477 are provided
by the EVAL-CONTROL-BRD2. Software to communicate
between the controller board and the AD7476/ AD7477 is
provided with the AD7476/AD7477 evaluation board kit. The
EVAL-CONTROL-BRD2 operates with all Analog Devices
evaluation boards with model numbers ending in the letters CB.

The 96-way connector is powered from a 12 V ac transformer.
Suitable transformers are available from Analog Devices as an
accessory under the following part numbers:

e EVAL-110VAC-US (for use in the U.S. or Japan)
e EVAL-220VAC-UK (for use in the UK.)
e EVAL-220VAC-EU (for use in Europe)

These transformers are also available from Digi-Key Corp.
(U.S.) and Campbell Collins, Ltd. (U.K.).

Connection between the EVAL-CONTROL-BRD?2 and the
serial port of a PC is accomplished via a standard printer port
cable, provided as part of the EVAL-CONTROL-BRD?2 kit.
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EVALUATION BOARD SOFTWARE

INSTALLING THE SOFTWARE

The EVAL-AD7476/AD7477CB kit includes self-installing
software on CD-ROM. This CD-ROM contains software for
controlling and evaluating the performance of the AD7476/
AD7477 when operated in conjunction with the EVAL-
CONTROL-BRD2.

Simply insert the CD into the drive on your PC, and an
installation program automatically begins. This program installs
the evaluation software onto the PC as well as electronic
versions of the evaluation board data sheets, the AD7476/
AD7477 device data sheet, and the EVAL_CONTROL-BRD2
data sheet.

CHECKING THE EVAL-CONTROL-BRD2

The EVAL-CONTROL-BRD2 and evaluation board should be
connected together as described in the Interfacing the
Evaluation Boards section.

At this stage, the red LED on the EVAL-CONTROL-BRD2
should be flashing. This indicates that the EVAL-CONTROL-
BRD2 is functional and ready to receive instructions.

Note that the software should be installed before the printer
port cable is connected between the EVAL-CONTROL-BRD2
and the PC. This ensures that the printer port has been
initialized properly.

THE MAIN SCREEN

The Main Screen, shown in Figure 3, allows you to read a
predetermined number of samples from the evaluation board
and display them in both the time and frequency domain. This
screen can be divided into three sections.

The upper portion of the screen contains the control buttons,
the menu bar, and the status windows.

Control Buttons

Use control buttons to take samples (Sample), reset the board
(Reset), and quit the program (Quit).

The Reset button resets EVAL-CONTROL-BRD2. The power
supplies are turned off and the program in DSP memory is lost.
Repeat the set up instructions to download another program if
required.

The Quit button exit the software, however programs running
on the EVAL-CONTROL-BRD?2 is not terminated.

Power Down and Power Up buttons allow you to power down and
then power up the device (see the AD7476/AD7477 data sheet).

Fl AD7476,/77/78 Evaluation Software =10l x|
File Printer Port Help
Sample FPower Down | |Configuration: 2048 Data Samples Uploaded
Part:AD7476 2048 Data Samples Uploaded —
ContSamp | PowerUp | Ip/oqram-ad7476 PRG 2048 Data Samples Uploaded m_a*_ci ggggg
Stop Samp Urtused Bits:12 2048 Data Samples Uploaded = :
- Code: Binary 2048 Data Samples Uploaded
Reset Quit Continuous Sampling Stopped
Woealad oa lacala A ln ol o p - [vols =
oK i i I 4 WA s
a5 JHEER 5 W [EE L= & Vertical Grid
3] l I{' '!' JJ 1 ]l | I |i- IV Horizontal Grid
25 ~ ¥ Hold Zoom
2 l|: _ f { 1 f { { % |[ / % L ™ Tick Data Paints
1.5
13 \ En 1] | A 15 e U 1] 1| E M ZoomHandles
054 A0 O P |
p e P ¥ VT 3
qd 50 100 150 200 250 300 350 400 450
0 . : c . . ~ | DCBins  Signal Bins
m = |2irs o 77
-40 - ~ |I” Hams [~ Avg
607 - | ¥ B-H Windowing
80 - - |SNR:  71.943dB
00 - THD: -80.168dB
4 | ! FREQ: 10107.4Hz £

Figure 3. Main Screen
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Menu Bar

The menu bar consists of the File, Printer Port, and Help menus.
The File menu offers the following selections:

e  Setup Menu. Select this option to display the Setup Menu
as shown in Figure 5.

e Load Raw Data. Select this option to load data saved by
the software during a previous session.

e  Save Raw Data. Select this option to save the current set of
sample data points. The data can be reloaded to the EVAL-
CONTROL-BRD?2 software later or used by other
programs for further analysis

e  Save Binary Data. Select this option to save the current set
of sample data points. The data is saved in binary format as
a text file. This method can be useful for examining code
flicker and looking for stuck bits.

e  Save FFT Data. Select this option to save the current set of
FFT data points. FFT data cannot be reloaded into the
EVAL-CONTROL-BRD?2 software, but can be loaded into
other software packages for further analysis.

e  Exit. Quits the program.

The Printer Port menu allows you to select which printer port
to use to communicate with the EVAL-CONTROL-BRD2.

e LPT1. This option selects 0x378 as the printer port
address. This is the default option.

e  LPT2. This option selects 0x278 as the printer port
address.

e  PRN. This option selects 0x3BC as the printer port
address.

The Help menu provides information about the current version
of evaluation board software.

Status Windows

The status windows display the setup of the evaluation board
and the device, along with the number of samples taken, and
other information, such as error messages generated.

Oscilloscope

The middle portion of the Main Screen is a Digital Storage
Oscilloscope (DSO). Samples uploaded from the EVAL-
CONTROL-BRD? are displayed here. Samples can be displayed
as integer values or as voltages. Once the samples are displayed,
clicking any point in the graph displays the sample number and
the value of the point directly beneath the cursor.

Zoom handles, which appear along the axis of the graph, allow
you to zoom in and out to get a closer look at a particular
sample. When another set of samples is taken, the graph
attempts to display all values collected unless the Hold Zoom
check box is checked. The graph retains the same axis settings
as for the previous set of data samples. Additional check boxes
are providing allowing you to control the vertical and
horizontal grids and data points.
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Figure 4. Main Screen, Histogram Mode

Fast Fourier Transform/Histogram

The lower portion of the main screen shows either a Fast
Fourier Transform (FFT) of the data or a histogram, which
shows the number of occurrences of each particular code read
back. The FFT (the default option) is typically used if you are
concerned with examining an ADC’s performance in the
frequency domain, while the histogram indicates the ADC's
performance with DC signals. The option displayed can be
changed by clicking on the FFT Mode/Histogram Mode button
at the top right of the screen. Figure 4 shows the Main Screen
with the histogram mode is selected.

SETUP MENU

The Setup Menu, shown in Figure 5, allows you to load the
required configuration file for the evaluation board. Once the
configuration file is loaded, the software acquires detailed
information about the AD7476/AD7477 evaluation board and
the device connected to the EVAL-CONTROL-BRD2. This
includes information such as the number of bits, maximum
sampling rate, output coding, maximum analog input, and
power supply requirement.

The configuration file also communicates to the software
the name of the DSP program file to download to the EVAL-
CONTROL-BRD2.

The Setup Menu allows you to choose the sampling frequency
and the number of samples to take.

Samples: 2048
Max Code: 4041
453  |Min Code: 38
222 |Spread: 4004
} Std Dev: 1414 573
166 |Mean:  2046.118
186
2l
454
RUNNING THE SOFTWARE

Once the software is installed and running, perform Step 1

through Step 3.

1. From the File menu, select Setup.

The Setup Menu displays. Notice that the Select a
Configuration File window lists all the available
configuration files. The configuration files are text-based
files containing information about the device to be tested.
The information includes the part name, number of
samples to be taken, default and maximum sampling
frequency, and power supply settings. The configuration
file also contains the name of the DSP program file to be
downloaded to the EVAL-CONTROL-BRD2.

2. Select the relevant configuration file and then click Load.

Choose the configuration file depending upon which
device is in the socket of the evaluation board. The EVAL-
CONTROL-BRD?2 is then reset and the DSP program is
downloaded. Once the download is complete, the power
supply settings indicated in the configuration file are set
and you may hear some of the relays clicking. The pull-
down menus, Select No. Of Samples and Select Sample
Frequency, are set to the default values specified in the
configuration file. Note that you can change these settings

at any point.
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3. Once all the settings are set, click Close to return to the
Main Screen.

SOFTWARE CONFIGURATION FILES

Software configuration files provide the EVAL-CONTROL-
BRD2 software with information on how the software and
hardware should perform. These files contain information, such
as the name of the DSP program to download, the default and
maximum sample frequencies, the number of samples to take,
and the power supply settings to use.

Typical Configuration File
A typical Software Configuration File (*.cfg) is shown here.

[EVAL-CONTROL BOARD]
partname:AD7476
programname:ad7476 .PRG

samplefrequency:100000
maxsamplefrequency:1000000
samples:2048

+/-15V:on

dvdd:5:0on

avdd:5:on

bus:on

;options 2scomp, binary
dataformat:binary
number of bits:12
inputVmax:5

inputvmin:o0

T
Select a Configuration File Select No. Of Samples Input Max [+]
2048 - 5.00
ad7477.clg l _l !
ad7478.clg Select Sample Frequency Input Min []
300000 | oo

Other Sample Frequency

300000 Hz Load ’

+12V AVDD DVDD AVDD DVDD BUS |{ i

| = i
[ o fo S P [N ..

Supply Settings

06243-005

Figure 5. The Setup Menu

TAKING SAMPLES

To instruct the EVAL-CONTROL-BRD2 to take the required
number of samples at the required frequency, follow these steps
using the Main Screen shown in Figure 3:

1. Click Sample.
Select a sampling frequency up to the rate of 1 MSPS.

Samples are uploaded and displayed. An FFT and
histogram are also calculated and displayed.

2. Click Cont Samp to continue taking samples.

3.  Click Stop Samp when you are finished taking samples.
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Figure 6. AD7476/AD7477 Evaluation Board Circuit Diagram
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Figure 8. Solder Side Artwork
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Figure 9. AD7476/AD7477 Evaluation Board Component Placement Drawing
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EVAL-AD7476/AD7471

ORDERING INFORMATION

BILL OF MATERIALS

Table 7. Components Listing

Qty. | Reference Designator Part Type Manufacturing Information | Order No.'

1 U1 AD7476/AD747677 Analog Devices AD7476ABKS/AD7477AAKS

1 U2 AD711 Analog Devices AD711KN

1 U3 OP467G Analog Devices OP467G

1 U4 74LS04 DM74LS04 FEC 373-450

1 U5 ADREF195 Analog Devices ADREF195GP

1 ué AD780 Analog Devices AD780AN

5 R1to R4, R6 1 kQ 0.25W 0.1% RC55 Welwyn Components Ltd. FEC 339-179

1 R5 3kQ 0.25W 0.19% RC55 Welwyn Components Ltd. FEC 339-635

2 R7,R8 5100.25W 1% MultiComp FEC 543-070

1 C10 0.1 pF ceramic 1206 case 12065C104KATDA FEC 895-210

1 c9 10 uF 20 VTAJ-C case TAJC106K020X FEC 498-798

2 c11,C12 68 pF ceramic MRO51A680JTA FEC 669-714

1 33 0.01 pF ceramic 50V MCDR25103X7RK0050 FEC 750-890

14 C2,(C4,C6,C8,C13,C14,C16,C18, 0.1 uF ceramic 50V MCDR25104X7RK0050 FEC 750-920
C20, C23, C25,C26,C29, C31

14 C1,C3,C5,C7,C15,C17,C19,C21, 10 uF 35V tantalum TAP10K35CCSY FEC 664-881
€22, C24,C27,C28,C30,C32

1 D1 SD103C Schottky diode SD103C

3 J1,J2,13 50 Q gold plated SMB M/A-COM FEC 310-682

1 J4 96-pin 90° DIN41612 plug Siemens AG FEC 269-931

1 J5 2-pin power connector Lumberg Group (KRM2) FEC 151-785

1 J6 3-pin power connector Lumberg Group (KRM3) FEC 151-786

3 LK1, LK2, LK3 2-way jumper (2 x 1) Harwin, Inc. FEC511-705

7 LK4 to LK11 2-way jumper (2 x 2) Harwin, Inc. FEC 511-791

1 LK12 2-way jumper (2 x 3) Harwin, Inc. FEC511-780

11 LK1 to LK12 Shorting links Berg Electronics FEC 528-456

4 T1,T2,73,T4 White testpoint W Hughes FEC 240-333

52 U2, U3, U4, U5, U6 Ultralow profile socket pins Harwin, Inc. FEC 519-959

4 Each Corner Rubber stick-on feet 3M FEC 148-922

1 PCB Evaluation Board Analog Devices EVAL-AD7476/AD7477CB

' Farnell Electronic Components.

ORDERING GUIDE ESD CAUTION

Model Description ESD (electrostatic discharge) sensitive device.

EVAL-AD7476CB AD7476 Evaluation Board Chtar:ge? ﬁivictés angltrfifcui; 'fﬁ_afds can tdif-"d‘tafge
. withou etection. oug IS produc eatures

EVAL-AD7477CB AD7477 Evaluation Board ‘ patented or proprietary protection circuitry, damage

Alad

may occur on devices subjected to high energy ESD.
Therefore, proper ESD precautions should be taken to
avoid performance degradation or loss of functionality.
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